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Font Xplorer Lite 1.2.2

Moon Software 

www.moonsoftware.com

freeware

Windows
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У пользователей ПК много хлопот: за ра-

ботоспособностью своего «железного дру-

га» необходимо следить постоянно. За

ним, как за маленьким ребенком, прихо-

дится все время присматривать. А тут еще

хакеры так и норовят подсунуть ему ка-

кую-нибудь бяку — «троянца» или, того

хуже, «Чернобыль». В таких ситуациях

весьма пригодятся антивирусы. Но не лю-

бые, а только те из них, что способны ра-

ботать в DOS. Как правило, коммерческие

антивирусные программы изначально име-

ют в своем дистрибутиве соответствующие

модули. А вот у бесплатных аналогов их

может и не быть. Правда, есть свободно

распространяемые DOS-модули платных

антивирусов, таких, например, как F-Prot.

DOS-версия этой программы бесплатна для

домашнего некоммерческого использова-

ния. При запуске F-Prot проверяет све-

жесть своих антивирусных баз и извещает

пользователя о необходимости их обнов-

ления. Запустив F-Prot, вы можете сразу

начать сканирование (Scan), а можете

предварительно определиться с ее уста-

новками (Options): проверять ли на со-

держание вирусов архивы, сжатые файлы,

поддиректории и использовать ли эври-

стический  механизм распознавания вре-

доносного кода (Use heuristics). 

Перед началом поиска можно также оп-

ределить его область — диски или диске-

ты (Search), вариант действий — лечить

или информировать (Action), и глубину

охвата файлов — все или только стан-

дартные (Files).   
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ÑÓ·˚È-‰Ó·˚È
‰ÓÍÚÓ DOS

F-Prot  3.12

Frisk Software

www.f-prot.com

freeware

Windows 

В отличие от Photoshop, пакет Photogenics

не ориентирован на обработку готового

изображения. Это скорее инструмент ху-

дожника: возможности создания картин и

их модификации поистине безграничны. 

К вашим услугам: свободная игра с цветом,

прозрачностью и методами обработки изо-

бражения прямо в месте приложения пе-

ра; набор реалистичных инструментов (аэ-

розоль, мелок, карандаш, акварель и т. д.);

добрая сотня эффектов, которые этими ин-

струментами могут накладываться; отдель-

ный блок эффектов с огнем; отдельные

24-битные каналы для RGB и уровня серо-

го; комбинированная система ступенчатого

и бесступенчатого undo/redo; многоокон-

ный просмотр изображения с разными ко-

эффициентами увеличения — и все это с

настоящим профессиональным качеством

32-битного цвета на каждый канал. Впро-

чем, программа не лишена недостатков.

Основной из них — условия ее распрост-

ранения: они не являются свободными.

Фактически это означает, что русификации

нет, и маловероятно, что она будет. Про-

грамма отлично управляется мышью, но

как владелец планшета я был очень рад

прочитать в релизе о поддержке планше-

тов Wacom. К сожалению, найти такой

поддержки в Linux-версии не удалось. 

В общем, программа производит очень хо-

рошее впечатление. Если вы предполагае-

те что-либо рисовать или модифицировать

готовые изображения, обязательно попро-

буйте этот инструмент.   
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Photogenics  5.0

Idruna Software

www.idruna.com

shareware

$699

Linux, Windows, Amiga

В конечном счете, как ни крути, работа на

компьютере — это работа со шрифтами.

Основным форматом шрифтов в системе

Windows является TTF, обеспечивающий

максимально точное соответствие изобра-

жения на экране тому, что в результате по-

лучится при печати на принтере. Большое

число бесплатных TTF можно найти на сай-

тах в Интернете, но далеко не все из них

поддерживают кириллицу. Но и это еще не

все. Многие русские гарнитуры создаются

на основе зарубежных прототипов. В ре-

зультате появляются шрифты-двойники,

одни из которых кириллические, а другие

только латинские. Программа Font Xplorer

Lite способна автоматически отличить од-

ни от других. Для этого достаточно выста-

вить в ее меню «Filter -> Character Set, Fa-

mily & Pitch» значение «Cyrillic». В этом

случае отображены будут только те шриф-

ты, которые поддерживают кириллицу.

Можно также определить, например, пара-

метр «Script» — тогда будут отфильтрова-

ны гарнитуры, имитирующие рукопись.

Значение «Decorative» заставит Font Xplo-

rer вычленить шрифты, использующиеся в

художественной графике.

Если какие-то шрифты используются час-

то, то с помощью этой программы их мож-

но установить в качестве постоянных («To-

ols -> Install Fonts») или временных

(«Tools -> Load Fonts»).

Очень интересная функция программы —

«Repair Wizard» — позволяет исправлять

ошибки в шрифтовом разделе системного

реестра.   

îÓÚÓ„ÂÌË˜Ì˚È
Â‰‡ÍÚÓ



Все мы, пользователи компьютеров, люди

разные, но есть нечто, что нас объединяет.

Это жажда ускорения. Способов увеличить

производительность компьютера существу-

ет несколько. Можно провести очередной,

сотый по счету, апгрейд или, например,

воспользоваться крохотной утилитой изве-

стного разработчика Альдоса Варгаса Spe-

edUp Processes. При запуске она отразит

все процессы, происходящие на вашем

компьютере в данный момент, расположив

их на нескольких закладках по уровню

приоритетности — от «Idle» до «Real

Time». Соответственно, вы вправе опреде-

лить ее значимость для каждой из испол-

няемых программ. Для этого достаточно

выделить на закладке «All» любой из пред-

ставленных процессов и, кликнув правой

кнопкой мыши, выбрать приоритет —

«Normal» (обычный), «High» (важный),

«Real Time» (сверхважный) или «Idle»

(приглушенный). Там же можно прервать

выполнение любой зависшей или просто

ненужной в настоящее время программы

(«Terminate Process»). 

Если кликнуть по кнопке «FreeMem», от-

кроется окно встроенной утилиты осво-

бождения оперативной памяти. Если же

выбрать функцию «Free Resources», то

процесс очистки RAM произойдет автома-

тически. Кроме того, вам предложат снять

процессы, занесенные пользователем в

специальный «черный» список («File > Edit

Kill list»). Отдельная услуга — запуск про-

граммы с заранее определенным приори-

тетом («File > Run»).   
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Aldo ’s  SpeedUp Processes  3.0

Aldos Vargas 

www.aldostools.com

freeware

Windows
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Были времена, когда очень много говорили

о так называемой научной организации

труда (НОТ), а проще говоря — о разумном

сочетании времени работы и отдыха. Сей-

час НОТ как-то позабылась, и мы часами

напролет сидим за компьютером, зараба-

тывая близорукость, гипертонию и остео-

хондроз. Некоторый порядок в расписании

рабочего дня может навести программа

GRL Auto Shut Down.

Окно полезной со всех точек зрения и к

тому же бесплатной утилиты состоит всего

из трех закладок. На первой «Basic Setup»

вводим или время работы («Count down

this amount of time»), или срок ее завер-

шения («Wait until this time»). 

На следующей закладке «Advanced Opti-

ons» определяем, что нужно сделать: пол-

ностью завершить работу ПК или только

прервать данный сеанс, перезагрузить

компьютер или, например, запустить ка-

кую-нибудь программу («When time expires

-> Launch an Application»). Третья страни-

ца «Network Options» отвечает за сетевые

установки.

Если ваш компьютер подключен к локаль-

ной сети, то с помощью GRL Auto Shut

Down можно управлять любым другим ПК

из окружения («Setup this computer to

control others») или, напротив, позволить

осуществлять контроль над вашей маши-

ной друзьям или коллегам. Если хотите

выключать или перезагружать удаленный

компьютер по таймеру, необходимо обя-

зательно ввести в соответствующем поле

ее IP-адрес.   
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GRL Auto Shut  Down 4.0n

GRL Technology

www.grltechnology.com

free for home use

Windows 
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Dee 1.1

Dee systems

http://dee.mp3.ms

freeware

Windows

Не могу отнести себя к заядлым мелома-

нам, хотя послушать хорошую музыку вре-

мя от времени люблю. С точки зрения вы-

бора проигрывателя я, наверное, совсем

неоригинален, используя WinAmp. Все-

таки при всех его недостатках — громозд-

кости и требовательности к системным ре-

сурсам — этот плейер по-прежнему

остается лидером в своем классе. 

К тому же он легко пополняется: если

стандартных функций недостаточно, к ним

всегда можно добавить плагины, один из

которых называется Dee и распространяет-

ся свободно. Как и любой другой плагин,

после инсталляции Dee необходимо акти-

визировать, выбрав его в меню «Options ->

Preferances -> DSP/Effect» проигрывателя

WinAmp. Если кликнуть там же по кнопке

«Configure», откроется окно с настройками

Dee. С первого взгляда заметно, что особое

внимание разработчики уделили точной

корректировке высоких и низких частот

(Treble и Bass). Они регулируются шестью

ползунками из девяти. Еще один «Mid

Amp» уточняет, соответственно, звучание

среднего диапазона. В принципе, все это

может быть настроено самостоятельно во

встроенном эквалайзере проигрывателя,

но с помощью Dee это проще. Самыми же

важными параметрами настроек, на мой

взгляд, являются «3D Amp» и «Reverb», от-

вечающие за трехмерность звучания и его

реверберацию. Последняя имеет четыре

уровня, моделирующих различные прост-

ранства: комнату (Room), клуб (Club), зал

(Hall) и город (City).   

çÓ‚˚È Á‚ÛÍ
WinAmp

á‡‚Â¯ÂÌËÂ
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Слышали ли вы что-нибудь о существова-

нии программ-невидимок? Я имею в виду

не многочисленные spyware, вирусы и

«троянцы», а полезные stealth-утилиты? 

Я, откровенно говоря, даже не подозревал,

что нужные программы можно прятать, по-

ка не познакомился с российским downlo-

ad-менеджером Spy Get. По основным сво-

им характеристикам это обычная утилита

для загрузки файлов из Интернета со стан-

дартным набором функций: загрузкой в

несколько потоков, восстановлением по-

сле обрыва связи, поддержкой proxy-сер-

веров для HTTP и очередью закачек. В об-

щем, ничего особенного. И не исключено,

что я не обратил бы внимания на этот

download-менеджер, если бы не его нео-

бычное свойство бесследно исчезать.

Попробуйте кликнуть «Файл -> Спрятать

Spy Get» и поищите его потом. На downlo-

ad-менеджер не переключишься по

«Alt+Tab», его невозможно отключить че-

рез «Ctrl+Alt+Del». Spy Get закрылся, но

ведь что-то или кто-то тем временем про-

должает загрузку — не призрак же, в кон-

це концов. Чтобы вновь сделать Spy Get

видимым, его необходимо перезапустить.

К достоинствам менеджера загрузок я могу

отнести также поддержку redirect-скрип-

тов, то есть непрямых ссылок, а также воз-

можность закачки всего сайта целиком. 

С другой стороны, у Spy Get есть и свои не-

достатки: прежде всего, в нем не предус-

мотрена функция перехвата ссылок у брау-

зеров и контроля Буфера обмена.    
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SpyGet  2.1

ÄÎÂÍÒÂÈ èÓ˜Ûı‡Ì

http://venom.nm.ru

free home use
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Windows

Каждому из нас хотелось бы держать руку

на пульсе жизни и постоянно находиться в

курсе событий. Неслучайно в американ-

ских фильмах герои произносят одну и ту

же фразу: «Все в порядке, ситуация под

контролем». В реальности, к сожалению,

добиться этого удается не всем. А вот в

виртуальном мире возможно все. Доста-

точно установить маленькую утилиту Hot-

keycontrol XP, и взаимодействие с компью-

тером изменится до неузнаваемости.

Технологию работы с этой программы не-

трудно определить даже из ее названия:

используя «горячие клавиши», вы сможете

перезагружать и выключать компьютер, за-

пускать приложения, управлять звуком, а в

Windows 2000/XP еще и командовать брау-

зером и мультимедиа. Некоторым стан-

дартным задачам в Hotkeycontrol XP уже

по умолчанию назначены персональные

управляющие клавиши клавиатуры. На-

пример, открытие и закрытие лотка CD-

ROM происходит при наборе «Shift+Esc»,

закрытие активного окна осуществляет со-

четание «Win+Z», а отключить звук можно,

нажав «Ctrl+Backspace».

Впрочем, вы вправе изменить эти значе-

ния, а также назначить свои «горячие кла-

виши» для имеющихся программ в основ-

ном окне Hotkeycontrol XP. Чтобы открыть

его, дважды кликните по иконке в систем-

ном трее. За открытие программ отвечает

закладка «Open», за браузер и мультиме-

диа — страница «Internet». К сожалению,

«горячие клавиши» можно назначать толь-

ко для восьми приложений.    
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Hotkeycontrol  XP 3.6

Digitalminer

www.digital-miner.com

freeware

Windows
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«Сталкер» 0

ÇÎ‡‰ËÏË äÓÔ˚ÎÓ‚,

è‡‚ÂÎ ä‡Â‚

http://astrologer.ru

freeware

Windows 

В астрологической программе «Сталкер»

загадочно все, даже нулевой номер ее бес-

платной версии. То есть «Сталкера» как бы

и не существует вовсе, хотя он вполне реа-

лен и устанавливается как любой другой

софт для Windows. Да и платных версий

вышло уже четыре. Далеко не все одно-

значно и с задачей, которую решает «Стал-

кер». Все-таки и церковь, и традиционная

наука категорически выступают против ас-

трологии. Если вы все же решитесь запус-

тить эту программу, то сможете мгновенно

получить так называемую натальную карту

расположения звезд на тот или иной день

и час. Для этого откройте окно ввода

«Файл > Ввести данные», выберите заклад-

ку «Гороскоп» и укажите в соответствую-

щих полях точное место, время и дату рож-

дения. В результате на экране появится

сложная схема — это и есть натальная

карта.  Чтобы получить пояснение к карте,

нужно кликнуть «Вид -> Текст интерпрета-

ции». Результаты, скажем прямо, показа-

лись мне неоднозначными: «Сталкер» тол-

кует двояко практически все. Так, у вас

может быть, по его мнению, или «систем-

ный логический ум», или «слабое ассоциа-

тивное мышление». 

Зато теперь вы сможете не только уз-

нать о себе то, о чем раньше даже не

подозревали, но и через меню «Вид ->

Карта событий» сделать прогноз на бу-

дущее или, точнее сказать, на опреде-

ленный вами день. Правда, он будет то-

же весьма неоднозначным.   
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Sean Fleming

http://gdis.seul.org

GNU GPL

Linux

На текущий момент в палитре музыкаль-

ного программного обеспечения для Li-

nux очевиден явный дефицит приложе-

ний, схожих по своим характеристикам

с недорогим полупрофессиональным

софтом для Windows. Мощные профес-

сиональные и дорогие программы, до-

ставшиеся в наследство от UNIX, суще-

ствуют. Простые аналоги «фонографа»

тоже присутствуют. А вот аналогов

SoundForge как-то не видно. На таком

«безрыбье» и появился ReZound. Не-

смотря на явно нестабильный номер

версии 0.3.0 (для устойчивых версий в

Linux принято в качестве точки отсчета

брать номер 1.0), программа ReZound

демонстрирует хорошую функциональ-

ность и имеет весьма завершенный вид.

Очевидные плюсы проекта — использо-

вание OpenGL для отображения; уже

протестированные модули для работы с

различными форматами файлов (Native

ReZound, WAVE, AIFF/AIFF-C, NeXT/Sun,

Berkeley/IRCAM/CARL, raw, Ogg Vorbis,

MPEG Layer-3, 2, 1); быстрая работа, в

том числе с большими файлами; много-

оконный интерфейс; приличный набор

функций редактирования; удобный кас-

кадный буфер; встроенные фильтры и

несложный интерфейс для подключения

новых плагинов. 

Из недостатков можно назвать отсутст-

вие поддержки LADSPA. В любом случае,

если вы интересуетесь обработкой зву-

ка в Linux, не пропустите этот довольно

интересный проект.   
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ReZound 0.3

Davy Durham

http://rezound.sf.net

GPL

Linux

Редкий пользователь Windows не пыта-

ется изменить в ее настройках хоть что-

нибудь, чтобы работала она быстрее и

выглядела симпатичнее. Тем более что

программ, занимающихся обустройством

этой системы, создано немало. Часть из

них — разнообразные выпадающие меню

виртуальные десктопы и shell-замените-

ли — по мере своих возможностей улуч-

шают интерфейс, другие — так называе-

мые твикеры, или ускорители —

оптимизируют работу всей Windows или

отдельных ее приложений.

Программа Windows Power Pro занимает

промежуточное положение между ними. С

одной стороны, она создает на Рабочем

столе панель для быстрого запуска прило-

жений, с другой — привносит ряд полез-

ных новшеств в саму систему. Войдите в

настройки «Configure Power Pro» (файл

pproconf.exe) и убедитесь в этом сами.

Так, на закладке GUI можно отключить

«ненужную» клавишу «Caps Lock», а на

странице «Key/Mouse» задать «горячие

клавиши» для самых разных действий.

Следующая закладка настроек «Schedu-

ler» предоставляет возможность запуска

приложений по расписанию. Далее следу-

ет «Media» — озвучивание событий Win-

dows с периодической заменой звуков и,

наконец, «Desktops» — девять виртуаль-

ных экранов. Для главной панели Power

Pro можно выбрать один из четырех ски-

нов. В дистрибутиве они представлены в

виде ZIP-файлов, которые следует распа-

ковать в папку «Skins». 
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Windows Power  Pro 3.3

Bruce Switzer

www.windowspowerpro.com

freeware

Windows

GTK Dismol  0.76

Начало учебного года ассоциируется с

творческим рвением многих школьников

что-нибудь изобрести или, в конце концов,

где-нибудь «нахимичить». Вот решили на-

химичить и мы, только в прямом, а не в пе-

реносном смысле. Представляем вашему

вниманию программу GTK Dismol. Ее автор

поставил своей целью создание инстру-

мента для отображения и манипулирова-

ния изолированными молекулами и пери-

одическими системами. Приложение

написано с использованием библиотеки

gtk+ (www.gtk.org), которая сегодня вхо-

дит в состав практически любого дистри-

бутива Linux. Хотя GTK Dismol и находится

в стадии разработки, она уже обладает не-

которой функциональностью. Например, в

ней реализованы: поддержка различных

форматов файлов; простые инструменты

для создания молекул и манипулирования

ими; окно диалога стартовой конфигура-

ции молекулы для динамического симули-

рования; набор различных инструментов

визуализации (геометрия, подсветка обла-

стей и т. д.) и анимация BIOSYM-файлов.

Приложение имеет интуитивно понятный

интерфейс. Стандартные функции меню

сочетаются с программно-ориентирован-

ными, такими как диалог измерений или

вывод периодической таблицы химиче-

ских элементов.   
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